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RUANG LINGKUP FLASH 

 
 

Terdapat beberapa istilah-istilah umum dalam program flash, yaitu: 
 

Animasi 
Rangkaian gambar yang disusun secara berurutan yang jika 
ditampilkan dengan kecepatan yang memadai, rangkaian gambar 
tersebut akan kelihatan bergerak. 

Actions Script 
suatu perintah yang diletakkan pada suatu frame atau objek sehingga 
frame atau objek tersebut menjadi interaktif. 

Movie Clip 
Suatu animasi yang dapat digabungkan dengan animasi objek yang 
lain. 

Frame Bagian layer yang digunakan untuk mengatur pembuatan animasi 

Scene Layar yang digunakan untuk menyusun objek-objek baik tulisan 
maupun gambar. 

Time Line  Bagian flash yang digunakan untuk menampung layer, 

Masking Perintah yang digunakan untuk menghilangkan sebuah isi dari suatu 
Layer dan isi Layer tersebut akan tampak saat movie dijalankan 

Layer Tempat yang digunakan untuk menampung suatu gerakan obyek.  

Keyframe Tanda titik atau lingkaran yang membatasi suatu gerakan animasi. 
Jika tanda lingkaran itu hitam maka keyframe tersebut berisi objek. 
Sebaliknya apabila keyframe tersebut berbentuk lingkaran kosong atau 
disebut juga Blank Keyframe maka keyframe tersebut tidak berisi 
objek. 

 
Untuk lebih memahami Flash, terlebih dahulu kita harus mengenal lingkungan kerja 

macromedia flash. Gambar di bawah ini menjelaskan tentang lingkungan kerja dari Macromedia 
Flash. 
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Konsep Dasar Animasi 
1. ANIMASI  

Animasi pada dasarnya berupa kumpulan atau potongan gambar yang ditampilkan bergantian 
secara cepat. Karena keterbatasan mata kita, kita tidak bisa membedakan setiap gambar yang 
satu dengan yang yang lainnya dan yang tampak  adalah sebuah gerakan yang disebut 
animasi. 
Animasi frame adalah animasi yang dibuat dengan menggunakan frame. Frame adalah suatu 
bagian dari layer untuk mengatur pembuatan animasi. Dalam film, setiap bagian gambar itu 
disebut frame. Frame-frame tersebut berganti dengan kecepatan tertentu. Kecepatan 
banyaknya frame yang ditampilkan dihitung dalam satuan frame per detik (fps = frame per 
scond). Film yan kita saksikan di bioskop menampilkan 24 frame per detik, Video tape dan 
televisi menampilkan 30 frame per detik. Semakin tinggi kecepatan dari frame maka gambar 
yang dihasilkan akan semakin halus tetapi kerugiannya adalah memerlukan jumlah frame yang 
lebih banyak dengan waktu yang sama. 
Misalnya film kecepatan 50 frame perdetik lebih baik daripada 25 frame perdetik, tetapi dengan 
waktu yang sama misal dua jam, untuk kecepatan 50 frame perdetik membutuhkan lebih 
banyak frame daripada yang kecepatannya 25 frame perdetik dan itu berarti sebuah 
pemborosan. Dengan menggunakan flash kita bias menentukan kecepatan frame dari animasi 
yang kita buat sehigga bisa optimal pada saat dimasukkan dalam web. 
 

2. SYMBOL DAN LIBRARY 
Symbol dan library adalah bagian yang sangat penting dalam membuat animasi. Untuk 
membuat suatu bentuk animasi, kita harus membuat bentuk tersebut menjadi symbol. Dengan 
mengubah suatu obyek menjadi symbol, artinya obyek tersebut  sudah menjadi bentuk yang 
tidak dapat diubah lagi. Jadi sebelum merubah suatu obyek menjadi symbol maka sebaiknya 
obyek tersebut harus benar benar sudah siap untuk digunakan sehingga tidak lagi ingin 
melakukan perubahan terhadap obyek tersebut. 
Tetapi kita bisa melakukan operasi mengubah bentuk di dalam stage seperti memutar, 
memperbesar atau memindahkannya.  
Untuk mengubah sebuah obyek menjadi symbol, blok terlebih dahulu obyek tersebut dengan 
menggunakan Selection tool (V)         dengan cara doble klik obyek tersebut. Jika  
sebuah obyek telah terblok maka obyek tersebut akan muncul titil-titik kecil pada 
permukaannya. Kemudian klik Modify > Confert to symbol sehingga muncul menu sebagai 
berikut : 

 
 
 
 
 
Isikan nama simbol sesuai 
dengan keinginan pada bagian 
Name.  

Pada bagian Type ada tiga pilihan yaitu : 
Movie clip  : obyek digunakan untuk beranimasi 
Button  : obyek dibuat sebagai tombol 
Grafik  : obyek dibuat sebagai gambar yang statis atau tidak beranimasi. 
Sebelum kita mengubah obyek menjadi symbol, kita harus mempunyai tujuan dari pembuatan 
symbol tersebut. Setelah selesai tekan tombol OK. 
Jika suatu obyek sudah berubah menjadi symbol maka obyek tersebut akan dibatasi oleh 
persegi empat berwarna biru dengan tanda + di ujung kiri atas dan bulatan ditengahnya. 
Library di dalam flash fungsinya adalah untuk menyimpan symbol yang pernah kita buat, 
walaupun sudah kita hapus dalam stage, symbol tersebut masih ada yang tersimpan dalam 
library. Untuk menampilkan library, klik menu window > Library. Untuk menampilkan pada 
stage kita tinggal drag dari obyek yang dimaksud. 

3. Instances 
Instance adalah duplikat dari symbol yang diletakkan dalam stage. Kita dapat membuat 
duplikat symbol yang ada dalam library berapapun jumlahnya. Drawing tool tidak dapat 
digunakan terhadap instance hal ini disebabkan karena instance merupakan duplikat dari 
symbol. Tetapi kita dapat mengubah instance misalnya memutar, memperbesar, atau 
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memperkecil, dimana perubahan tersebut tidak akan mengubah symbol yang masih ada dalam 
stage.  

4. Penggunaan Timeline 
Didalam flash frame-frame dari animasi diletakkan dalam bagian time line. Ditempat tersebut 
kita dapat mengatur frame yang digunakan untuk animasi.  
 
 
 
 
 
 
 
 
 
 
Didalam time line terdapat timeline header yaitu bagian yang terdapat angka 1, 5, 10, dst itu 
berguna untuk menunjukkan letak frame. Jadi jika kita membuat sebuah animasi maka gerakan 
dari gambar akan dimulai dari frame ke satu, dilanjutkan kedua dan seterusnya hingga animasi 
berakhir. Playhead yang selanjutnya kita sebut sebagai penunjuk frame yaitu garis  vertikal 
berwarna merah berguna untuk menunjukkan posisi dari frame yang ditampilkan pada stage. 
Playhead dapat dipindah ke frame yang kita inginkan cukup dengan mengklik frame tersebut. 
Misalnya terdapat animasi bola yang bergerak dari kiri ke kanan. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

5. Penggunaan layer control 
Didalam flash juga terdapat layer yang fungsinya sama dengan didalam photoshop yaitu untuk 
memisahkan beberapa gambar atau animasi. 

 
1. New Layer : digunakan untuk menambah layer di dalam timeline 
2. Guide Layer : Ada dua tipe dari layer yaitu mask dan guide. Keduanya digunakan untuk 

animasi yang khusus dan akan dijelaskan pada bab selanjutnya 
3. Hide/ Show Layer : fungsinya sama dengan pada photoshop yaitu untuk menampilkan 

atau menyembunyikan suatu layer 
4. Lock/ Unlock Layer : Kita bisa melindungi layer dengan cara menguncinya sehingga tidak 

bisa kita ubah ketika kita sedang bekerja dengan layer lainnya 

Timeline header 

Playback timeline 

 
playhead diletakkan pada frame 1 maka 
stage utama akan menampilkan 
gambar yang ada dalam frame 1 

 
Playhead diletakkan pada frame 10 
maka stage utama menampilkan 
gambar yang ada dalam frame 10 
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5. Delete Layer : digunakan untuk menghapus layer 
6. Outline Layer : digunakan untuk menyembunyikan obyek dan hanya menampilkan tepinya 

saja 
Seperti yang ada dalam photoshop, layer yang saat itu 
sedang aktif ditunjukkan dengan gambar pensil. Untuk 
memindah letak layer aktif tinggal mengklik layer lain yang 
diinginkan sehingga gambar pensil pindah ke layer baru 
tersebut. Setiap layer mempunyai timeline sendiri yang 
letaknya sejajar dengan masing masing layer dan pada saat 
animasi dijalankan maka timeline dari tiap tiap layer tersebut 
akan berjalan secara bersamaan mulai dari frame pertama 
hingga animasi berakhir. 

 
6. Keyframe 

Pada film animasi, memainkan 24 frame perdetik dengan durasi waktu 90 menit, membutuhkan 
129600 frame yang harus dibuat. Sebelum ada bantuan komputer semua frame tersebut harus 
dibuat secara manual satu persatu sehingga membutuhkan waktu yang sangat lama.   Dalam 
flash kita tidak perlu membuat frame satu persatu persatu karena dibantu oleh adanya 
keyframe. Key Frame adalah frame yang berperan sebagai titik referensi, yang biasanya 
menggambarkan momen waktu utama. Sebagai  contoh jika ingin membuat animasi lari jarak 
pendek 100 meter, maka kita bias memiliki key frame berikut 
- Key frame 1 : pelari berdiri   
- Key frame 2 : pelari menempatkan posisi kakinya 
- Key frame 3 : pelari mengambil posisi siap 
- Key frame 4 : pelari melawati garis star 
Jika dari awal adegan sampai akhir dibutuhkan 15 detik (dengan kecapatan 24 fps)  maka kita 
membutuhkan 360 frame. Dari 360 frame tersebut, empat diantaranya kita jadikan keyframe 
yaitu sebagai titik referensi, sedangkan sisanya disebut sebagai in-between frame.   Tanda 
bahwa suatu frame sudah menjadi keyframe adalah adanya bulatan kecil berwarna hitam pada 
frame tersebut, agar suatu frame bisa diedit, misalnya dimasukkan gambar, diberi warna, 
tulisan dll maka frame tersebut harus diberi keyframe. Jadi keyframe merupakan syarat mutlak 
pada suatu frame agar frame tersebut bisa diisi atau diedit. Jika frame tersebut tidak 
mempunyai keyframe maka tidak bisa dilakukan pekerjaan apapun terhadapnya. 
 
 
 
 
 
In-Between Frame 
In-Between Frame berfungsi untuk memainkan film diantara Key Frame. In-Between frame ini 
akan menjembatani keadaan transisi dari satu Key Frame ke Key Frame yang lain. Misal key 
frame yang pertama adalah gambar bola disebelah kiri, dan keyframe yang kedua gambar bola 
disebelah kanan, maka in-betweeen framenya adalah gambar perubahan letak bola secara 
perlahan dari kiri ke kanan. Seperti telah dijelaskan sebelumnya jika suatu keyframe berada 
dalam keadaan in-between frame maka frame tersebut tidak bisa dimanipulasi. 
 
 
 
 
 
 
 
 
Untuk memasukkan keyframe kepada suatu frame pilih 
frame yang diinginkan kemudian klik kanan. Pada menu 
tersebut ada dua pilihan yang bisa  digunakan untuk 
memasukkan keyframe  ke dalam frame yaitu insert 
keyframe dan insert blank keyframe. 
 

Layer 3 Aktif 

In-between frame 

Keyframe 
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insert keyframe 
Jika kita memilih menu insert keyframe itu artinya adalah kita  memasukkan keyframe ke 
dalam frame tersebut sekaligus mengkopi gambar yang ada dalam keyframe sebelumnya.  
 
insert blank keyframe 
Jika kita memilih blank keyframe itu berarti kita mengisikan keyframe pada frame tersebut dan 
isinya masih kosong, belum terdapat gambar apapun. 
 
Animasi diantara dua keyframe 
Untuk membuat sebuah animasi minimal kita harus menggunakan dua  buah keyframe. 
Keyframe yang pertama diberi suatu gambar, dan keframe yang kedua diberikan gambar yang 
berbeda, misalnya berbeda letak atau warna. Kemudian kita gerakkan diantara keduanya 
sehingga terjadi perubahan yang perlahan lahan dari keyframe yang pertama hingga keyframe 
yang kedua, itulah yang disebut sebagai animasi. 
 
Mengatur movie properties 
Sebelum membuat sebuah animasi kita harus melakukan setting dari animasi yang akan kita 
buat. Untuk itu pilih menu modify>movie sehingga muncul kotak dialog movie properties. 
 
 
 
 
 
 

 
 
 

Frame rates:   digunakan untuk mengatur kecepatan dari animasi seperti yang telah dijelaskan 
pada bab sebelumnya. Didalam animasi flash kecepatan yang optimal adalah 12 
fps.  kita bisa menambah atau mengurangi kecepatan file tersebut Jika semakin 
kecil  kecepatannya maka ukuran file lebih kecil tetapi gambar akan tampak 
patah patah. Dan  begitu juga sebaliknya. 

Dimension: untuk mengatur ukuran dari stage, dan juga ukuran animasi pada saat 
dimasukkan dalam web. Satuannya bisa diubah pada ruler units. 

Backgroud color: untuk menentukan warna dari background 
Sebaiknya anda harus melakukan penyettingan movie properties ini setiap akan membuat 
sebuah animasi. 
 
Konversi File melalui Flash 
Anda dapat melakukan konversi file melalui flash MX. File yang dikonversi biasanya berbentuk 
file *.swf ke dalam bentuk lainnya, seperti *.html, *.exe, *.avi, dan lain sebagainya. Untuk 
mengkonversi file flash yang telah Anda buat, terlebih dahulu Anda harus mengaktifkan 
konverternya terlebih dahulu. Cara mengaktifkannya yaitu dengan memberi checkmark pada 
type file yang Anda inginkan. Untuk mengaktifkan publish settings Anda dapat memilih menu 
File > Publish Settings… (Ctrl+Shift+F12). 
 

Keterangan: 
- Flash (.swf) : Menghasilkan file *.swf (untuk 
menjalankannya dibutuhkan flash player). 

- Html (.html) : Menghasilkan file *.html (diperlukan 
internet explorer untuk menjalankannya). Konversi ini 
biasanya digunakan untuk membuat web. 

- Gif, Jpeg, Png : Menghasilkan file gambar. 
- Windows Projector : Menghasilkan file *.exe yang dapat 
langsung dijalankan.  

- Macintosh Projector : Menghasilkan file *.hqx untuk 
macintosh. 

- Quick Time : Menghasilkan file *.mov untuk Quick time 
player. 
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PEMBUATAN TOMBOL 
 
Dalam flash diberikan fasilitas yang sangat banyak untuk pembuatan tombol sehingga dapat dibuat 
tombol yang interaktif yang berbeda dengan tombol-tombol pada umumnya. Tombol bisa kita 
gunakan untuk membuat link dari satu halaman ke halaman yang lain  atau juga digunakan untuk 
fungsi-fungsi yang lain sehingga web kita lebih interaktif. 
Agar suatu obyek bisa berubah menjadi tombol dan dapat diberi fasilitas-fasilitas yang 
berhubungan dengan tombol maka obyek tersebut harus diubah lebih dahulu menjadi symbol 
button.  

1. Mengubah Obyek Menjadi Symbol 

Untuk mengubah suatu obyek menjadi tombol maka blok terlebih dahulu obyek yang akan 
dijadikan tombol lalu pilih menu Modify > Convert to symbol dan pilih Button. 
 
 
 
 
 
 
 
Berilah nama tombol yang dapat ditulis pada Name kemudian klik OK. Hal ini akan mempermudah 
apabila akan mempergunakan tombol yang sama untuk lokasi berbeda dengan cara mengambil 
melalui Lybrary. Tanda bahwa obyek tersebut telah dikonversi kedalam symbol yaitu muncul garis 
tepi persegi berwarna biru muda. 

2. Memanipulasi Tombol 

Tombol yang interaktif biasanya berubah-ubah sesuai dengan kondisi mouse. Misalnya mouse 
berada di atas tombol maka bentuk atau warna tombol berubah. Kemudian jika tombol di klik maka 
bentuk atau warna berubah lagi yang lain.  

Untuk membuat hal tersebut klik kanan tombol yang akan dimanipulasi, kemudian pilih Edit. Jika 
telah dipilih option Edit maka obyek tombol yang di klik tersebut akan masuk ke dalam ruangan 
tersendiri khusus untuk memanipulasi tombol yang dipilih tersebut.  

Di dalam edit stage tersebut  di bagian timeline bentuknya berubah 
menjadi seperti disebelah kanan ini. 
Ditempat tersebut tedapat empat pilihan frame yaitu Up, Over, Down, 
Hit. 
Up : bentuk tombol pada saat mouse berada di luar tombol. 
Over : bentuk tombol pada saat mouse berada di atas tombol. 
Down : bentuk tombol pada saat mouse menekan tombol. 
Hit : untuk menentukan luas area dari tombol. 
Untuk lebih jelasnya ikuti langkah-langkah berikut : 
1. Buka image baru dengan ukuran 550 x 400 pixels, white. 
2. Buat obyek di dalamnya misalnya lingkaran. 
3. Blok lingkaran lalu klik menu Modify > Convert to Symbol kemudian pilih Button. 
4. Klik kanan dan pilih Edit. Pada bagian time line akan muncul key frame pada bagian Up yang 

lain masih kosong itu artinya adalah obyek yang dibuat pertama kali sebagai tombol secara 
default akan menjadi bagian Up yaitu keadaan tombol pada saat mouse berada diluar area 
tombol. Kita bisa mengganti bentuk atau warna tombol pada bagian Up.  

     Bentuk tombol  
 
 
 
5. Jika pada bagian Over menggunakan obyek yang sama nengan pada Up maka isikan key frame 

pada over, dengan cara klik kanan frame over dan pilih Insert keyframe. Dapat juga diberi 
perubahan seperti berikut : 
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     Bentuk tombol 
 
 
 
6. Langkah yang sama juga dilakukan pada bagian down, yaitu pada saat mouse mengklik pada 

bagian tombol. Disini juga bisa diubah bentuk atau warnanya. 
 
     Bentuk tombol 
 
 
 
7. Apabila bagian over akan anda beri animasi suara maka 

sebelumnya import terlebih dulu sound efect kedalam 
library dengan langkah pilih menu File > Import > 
Import to library …. Pilih sound efect yang dikehendaki 
kemudian klik Open maka sound tadi akan masuk 
kedalam Library.  

8. Untuk memasukkannya suara kedalam tombol, klik kanan 
terlebih dahulu tombol yang telah diatur up, over dan 
down-nya tadi, kemudian pilih Edit maka tombol akan 
masuk kedalam ruang edit. 

9. Buat layer baru beri nama Sound O, buka sound efek yang 
ada dalam library dengan cara klik menu Window > 
Library. Maka akan muncul kotak Library yang 
didalamnya telah ada sound yang tadi telah anda ambil. 

10. Anda aktif di dalam layer2, Drag salah satu sound kedalam 
stage (mis. S41.WAV). Kemudian drag awal sound yang 
ada di up untuk ditarik kedepan sehingga berada pada 
Over. 

11. Begitu pula untuk  pengisian suara pada Down. Buat layer 
baru beri nama Sound D, buka sound efect yang ada 
dalam lybrary (mis: BOBM3.WAV) yang telah anda import. Drag ke dalam stage. 

12. Drag frame up pada leyer Sound D dan tarik ke kanan hingga frame down. 

13. Kembali ke halaman utama dengan mengklik tombol Scene 1    
14. Untuk mencoba pilih menu Control>test ovie atau tekan Ctrl + Enter. 
Jika berhasil maka saat mouse di luar tombol, di daerah tombol, dan pada saat mengklik tombol 
akan menunjukkan perbedaan. 
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ANIMASI MENGGUNAKAN ACTION SCRIPT 
 
ActionScript adalah bahasa skripting di Flash. Anda dapat menggunakan ActionScript untuk 
mengontrol objek di Flash, membuat navigasi dan elemen interaktif lain, serta membuat movie 
Flash dan aplikasi Web yang interaktif. Dalam pembuatan animasi, selain menggunakan Movie Clip, 
kita juga dapat menggunakan fasilitas perintah Action Script. Perintah ini digunakan untuk 
membuat animasi interaktif yang lebih komplek dibanding apabila hanya menggunakan Movie Clip.  
 

� Fungsi Panel Action Script 

 
Panel Action Script digunakan untuk memberikan perintah action pada sebuah frame, objek 
tombol, atau Movie Clip Instance. Langkah untuk membuka jendela Actions adalah dengan 
menekan tombol F9 ayau klik menu Windows > Actions. Gambar di bawah adalah bagian-bagian 
dari jendela Actions. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
Action adalah sebuah perintah yang akan dibaca atau dijalankan saat playhead melewati keyframe 
yang diberi perintah Action tersebut. Playhead adalah garis penunjuk yang bergerak dari satu 
frame ke frame yang lain. 
 

� Konsep-konsep dasar ActionScript 

 
Objek dan Kelas 
Objek adalah tipe data seperti suara, gambar, teks yang digunakan untuk mengontrol movie. 
Semua objek merupakan bagian dari suatu kelas. Flash memiliki variasi bentuk objek yang sangat 
beragam, mulai dari gambar yang kelihatan sampai dengan yang abstrak seperti tanggal, data, 
atau deteksi masukan dari mouse. Sebelum kita dapat menggunakan objek, kita perlu memberi 
nama pada objek tersebut, sama seperti tiap orang perlu memiliki nama supaya dapat dikenali. 
Misalnya Ballerina, Flintstone, dan Napi dapat dibedakan berdasar nama mereka.  
Di samping objek yang kita definisikan sendiri, Flash juga memiliki predefined class yang dapat 
digunakan membuat objek-objek untuk dipakai dalam movie. Objek-objek ini berada di dalam 
kategori Objects di dalam ActionScripts, misalnya MovieClip, Color, Sound, dll. Objek dari 
predefined class ini juga harus diberi nama. Proses memberi nama objek ini dinamakan 
instantiating. Karena objek yang berasal dari kelas tertentu, sesungguhnya dapat dianggap bahwa 
objek tersebut adalah juga merupakan instance dari kelas. Ballerina, Flintstone, dan Napi masing-
masing merupakan instance dari kelas manusia. 
 
Metode dan Properti 
Setiap objek selain berbeda dalam nama, juga berbeda dalam karakteristik. Setiap orang berbeda 
dalam berbagai karakteristik seperti jenis kelamin, tinggi badan, berat badan, dan warna rambut. 

Nama-nama 
kelompok 
perintah script 

Tempat penulisan perintah 
Action Script 
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Di dalam ActionScript karakteristik-karakteristik ini dinamakan properti. Misalnya kelas MovieClip 
memiliki berbagai properti seperti _height, _width, dan _rotation yang mengukur dimensi dan 
orientasi dari objek movie klip tersebut. 
Objek juga melakukan suatu tugas. Seseorang dapat tidur, bekerja, makan. Pekerjaan ini di dalam 
ActionScript dinamakan metode. Misalnya kelas Sound memiliki metode setVolume yang dapat 
membuat suara lebih keras atau lebih lembut. 
Tip: Untuk memudahkan, anggaplah objek sebagai kata benda, properti sebagai kata sifat yang 
menerangkan objek dan metode sebagai kata kerja yang menerangkan tindakan apa yang 
dilakukan objek. 
 
Struktur Bahasa ActionScript 
Seperti halnya dalam menggunakan bahasa alamiah, kita perlu menempatkan kata benda, kata 
sifat, dan kata kerja dalam susunan yang dimengerti orang lain. Di sini kita menyusun objek, 
properti dan metode sampai membentuk statement, atau pernyataan, yang dimengerti Flash. 
Flash 5 menggunakan struktur bahasa sintaks dot, yang menggantikan sintaks slash pada versi 
terdahulu. Dot atau titik digunakan untuk menunjukkan properti atau metode yang terkait dengan 
objek. Contoh: 
Ballerina.berat = 50 
Flintstone.berat = 65 
Pernyataan di atas menetapkan nilai 50 untuk properti berat dari Ballerina, dan nilai 65 untuk berat 
dari Flintstone. 
Ballerina.pakaian.warna = putih 
Pernyataan di atas menjelaskan putih sebagai properti warna pada objek pakaian yang terkait 
dengan objek Ballerina. (Di sini properti pakaian milik Ballerina merupakan objek juga, yang 
memiliki propertinya tersendiri). 
Ballerina.menari() 
Pernyataan di atas menjelaskan metode menari yang diterapkan pada objek Ballerina. Tanda 
kurung buka dan kurung tutup memberi tanda kalau menari adalah metode.  
Ballerina.menari(cepat) 
Ballerina.menari(lambat) 
Metode seringkali memiliki argumen atau parameter, yang menerangkan bagaimana seharusnya 
metode dijalankan. 
Tip: Untuk memudahkan, bacalah dot syntax dari belakang. Misalnya Ballerina.pakaian.warna = 
putih dapat dibaca “Putih adalah warna pakaian dari Ballerina.” 
 
Tanda Baca dalam ActionScript 
Seperti dalam bahasa tulisan memiliki tanda baca untuk mengakhiri kalimat, atau mengelompokkan 
berbagai kalimat menjadi satu paragraf, Flash juga memiliki tanda baca seperti itu. 
Kurung kurawal dan titik koma 
Kurung kurawal, { }, digunakan untuk melakukan pengelompokan. 
on(release) { 
      stopAllSounds(); 
      play(); 
} 
Dalam skrip di atas, kedua metode stopAllSounds dan play akan dieksekusi saat tombol mouse 
dilepaskan karena berada dalam satu kelompok. Ini seperti paragraf. 
Titik koma berfungsi seperti tanda akhir kalimat yang setelah kalimat pertama berakhir kemudian 
beralih ke kalimat berikutnya. Di dalam ActionScript, setiap pernyataan dieksekusi dari atas ke 
bawah secara berurutan. Jadi pada contoh di atas, setelah metode stopAllSounds selesai baru 
kemudian play dijalankan. 
 
Komentar 
Komentar adalah keterangan yang ditambahkan di dalam skrip untuk menjelaskan apa arti kode 
tersebut. Komentar dapat membantu memahami skrip apabila Anda hendak mereview kembali 
kode tersebut untuk perbaikan. Komentar diawali dengan dua buah garis miring, //, dan berlaku 
hingga akhir baris. 
on(release) { 
      // matikan semua suara 
      stopAllSounds(); 
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      // mainkan  
      play(); 
} 
 
Action Panel 
Anda dapat membuat ActionScript di dalam Action Panel. Kelebihan Action Panel adalah dapat 
mengotomatisasi sebagian dari proses penulisan skrip, misalnya menambahkan kurung kurawal 
dan titik koma secara otomatis. 
Di Flash, nama Action Panel muncul sebagai Frame Action Panel apabila skrip diaplikasikan ke 
Frame atau Object Action Panel apabila skrip diaplikasikan ke objek. 
Untuk membuka Action Panel, lakukan salah satu dari cara di bawah ini:  

• Dari menu bar, pilih Window > Actions. 
• Seleksi objek atau frame, kemudian klik gambar panah di Launcher Bar yang berada di 

bagian kanan bawah stage.  
• Klik dua kali pada frame. 

 
Mode Normal dan Mode Expert  
Anda dapat menggunakan Action Panel pada mode expert atau mode normal. Mode expert, yang 
baru muncul di Flash 5, ditujukan bagi mereka yang sudah terbiasa dengan bahasa pemrograman. 
Menggunakan mode expert sama dengan Anda menuliskan program melalui editor teks seperti 
Notepad. Sementara pada mode normal Anda diberikan pilihan-pilihan elemen lewat interface 
menu dan daftar toolbox. 
Pada mode normal, Anda dapat menuliskan action dengan berbagai cara, yaitu: 

• Tekan tombol + untuk membuka menu pulldown berisi kategori action. Pilih action yang 
sesuai dalam menu tersebut. 

• Klik kategori action di daftar Toolbox, kemudian dobel klik pada action yang dipilih. 
• Drag and drop action yang ada di daftar Toolbox ke daftar Action. 

Untuk beralih dari mode normal ke mode expert, klik tombol segitiga kecil di bagian kanan atas 
Action Panel. 
 
Kategori ActionScript 
Dalam mode normal, action dibagi dalam berbagai kategori, yaitu: 

1. Basic Actions. Kategori ini menampung action sederhana yang sering sekali digunakan 
untuk movie Flash, seperti navigasi dan perilaku tombol. 

2. Actions. Kategori ini meliputi Basic Actions ditambah dengan banyak action lain yang lebih 
kompleks. 

3. Operators. Kategori ini berisi simbol yang digunakan misalnya untuk operasi logika dan 
matematika, seperti tambah, kurang, kali, dll. 

4. Functions. Function berisi action yang dapat menerima data tertentu untuk kemudian 
menghasilkan informasi yang dapat kita gunakan. 

5. Properties. Kategori Properties berisi properti objek yang dapat dimodifikasi. Sebagian 
besar properti ini digunakan untuk objek klip movie. 

6. Objects. Flash memiliki kelas objek yang sudah didefinisikan (predefined class). Kelas-kelas 
ini berada dalam kategori Objects di ActionScript. 

 
Navigasi 
Salah satu fungsi mendasar dari ActionScript adalah untuk membuat navigasi movie Flash. Yang 
dimaksud navigasi ini adalah bagaimana membantu user untuk masuk ke bagian-bagian movie 
tertentu misalnya frame atau scene tertentu. Navigasi ini erat kaitannya dengan sistem menu dan 
struktur konten suatu movie Flash. 
Untuk navigasi standar, action yang paling banyak digunakan adalah action yang terdapat dalam 
kategori Basic Actions, yaitu: Stop, Play, dan GoTo. Stop digunakan untuk menghentikan movie, 
Play digunakan untuk menjalankan movie. Sedangkan GoTo memiliki dua variasi, yaitu 
gotoAndPlay dan gotoAndStop. Sesuai dengan namanya gotoAndPlay memerintahkan Flash untuk 
masuk ke frame atau scene tertentu dan memainkannya. Action gotoAndStop adalah kebalikannya. 
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Menghentikan Movie 
Buka file yang disertakan di dalam CD, Navigasi project.fla (dapat juga didownload dari 
mwmag.com). Lakukan Test Movie (Ctrl+Enter). Anda akan melihat suatu animasi yang cukup 
panjang terdiri dari 96 frame.  
Anda akan melihat bahwa movie dimainkan terus menerus (loop). Anda sama sekali tidak memiliki 
kontrol terhadap animasi tersebut. Kita akan mengontrol movie dengan skrip sederhana berisi 
action stop, play, dan goto. Buat layer baru dengan nama action. Anda akan menempatkan 
action di frame di layer tersebut. Biasakanlah untuk membuat action di layer tersendiri supaya 
memudahkan revisi. 
Seleksi frame terakhir, yaitu frame 96. Kemudian klik kanan dan dari menu pulldown pilih Insert 
Blank Keyframe. 
Klik dua kali frame terakhir, yaitu frame 96 untuk membuka Frame Action Panel. Masukkan skrip 
sederhana berikut: 
stop(); 
// Tekan + > Basic Actions > Stop 
Tutup Action Panel. Perhatikan keyframe 96, Anda akan melihat terdapat simbol huruf alfa. Ini 
berarti frame tersebut sudah memiliki action di dalamnya. 
Lakukan Test Movie. Movie akan berhenti di frame terakhir. 
 
Menambahkan Action goto 
Sekarang Anda akan menambahkan action goto ke dalam movie. Dobel klik frame terakhir di layer 
(96) untuk membuka kembali Action Panel. 
Pilih baris pertama yang mengandung action stop, kemudian klik tanda minus (-) untuk menghapus 
action tersebut. Kemudian tambahkan action goto: 
gotoAndPlay(66); 
// Tekan + > Basic Action > Go To 
// pada isian Frame masukkan angka 66 
Lakukan Test Movie. Anda akan melihat movie dimainkan pertama kali sampai frame terakhir 
kemudian kembali ke frame 66. 
 
Lebih Lanjut Mengenai Action Goto 
Action gotoAndPlay ataupun gotoAndStop memiliki beberapa parameter yang penting untuk 
diperhatikan. Dengan mengubah parameter Anda dapat memerintahkan Flash untuk menuju 
frame, scene, atau label frame tertentu. 
 
Menggunakan Tombol untuk Navigasi Movie Flash 
Selama ini Anda tidak dapat secara interaktif mengontrol jalannya movie. Anda menggunakan 
tombol untuk navigasi movie Flash. Untuk itu digunakan mouve event. Movie event sebenarnya 
hanya salah satu dari beberapa event handler. Ada beberapa macam event handler, yaitu Mouse 
Event, Key Event, dan Clip Event. Untuk saat ini kita hanya membahas Mouse Event. Event 
menandakan suatu kejadian yang terjadi, kalau dinamakan mouse event, secara sederhana dapat 
dikatakan mouse event tersebut adalah segala kejadian yang berkaitan dengan mouse, baik itu 
penekanan tombol mouse, pergerakan mouse, dll. 
Latihan… 
• Buka file Navigasi project.fla. 
• Buat layer baru dengan nama action kemudian klik dua kali frame 1 dan berikan action stop 
untuk frame 1. 

• Buatlah sebuah instans tombol di layer baru. 
• Seleksi instans tombol tersebut kemudian buka Action Panel (dari menu bar Window > Actions). 
Masukkan skrip berikut untuk tombol: 
on (release) { 
    gotoAndPlay(2); 
} 
// Tekan + > Basic Actions > Go To 
// Di pilihan Frame masukkan frame yang dituju yaitu 2 

Saat action goto dipilih maka Flash otomatis memunculkan salah satu even mouse, yaitu on 
(release), di mana even ini merupakan default Flash, sebab sering digunakan. Even on (release) 
menerangkan apa yang akan terjadi saat tombol mouse diangkat. Dalam contoh di atas Anda 
memerintahkan untuk memainkan movie mulai dari frame 2.  
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Lakukan Test Movie. Sekarang Anda perlu menekan tombol untuk memainkan movie.  
Buat 2 buah instans tombol lagi di stage. Seleksi salah satu tombol dan buka Action Panel. 
Masukkan skrip berikut: 
on (release) { 
    stop(); 
} 
// Tekan + > Basic Actions > On Mouse Event 
// Tekan + > Basic Actions > Stop 

Seleksi tombol yang lain, kemudian masukkan skrip berikut: 
on (release) { 
    play(); 
} 
// Tekan + > Basic Actions > On Mouse Event 
// Tekan + > Basic Actions > Stop 

Lakukan Test Movie. Anda akan melihat, bahwa Anda dapat menghentikan atau memainkan movie 
pada titik di mana Anda inginkan dengan menekan dua tombol terakhir. 
  
Lebih Lanjut Mengenai Even 
Even mouse adalah satu dari beberapa jenis even yang diberikan Flash. Yang lainnya yaitu even 
Key dan even Clip. Even Key mengacu pada apa yang terjadi dengan keyboard, sementara even 
Clip mengacu pada apa yang terjadi di klip movie. Untuk even mouse sendiri, selain release, 
terdapat pula even lain yang dapat dimonitor.  
Anda dapat mencoba sendiri bereksperimen dengan berbagai even mouse tersebut. Sebagai 
catatan, tidak hanya satu buah even mouse saja yang dapat diterapkan pada tombol. Anda dapat 
menerapkan berbagai even untuk satu instans tombol. Misalnya: 
on (rollOver) { 
    play(); 
} 
 
on (rollOut) { 
    stop(); 
} 
 
on (release) { 
    gotoAndPlay(2); 
} 
Pada contoh di atas, dengan instans tombol yang sama Anda menerapkan tiga buah handler even 
yang berbeda. Pada saat pointer mouse bergerak di atas area hit tombol maka movie dimainkan, 
sedangkan saat pointer bergerak menjauhi area hit maka movie klip dihentikan. Dan pada saat 
tombol mouse dilepas—setelah tombol ditekan tentunya—movie akan dimainkan kembali dari 
frame 2. 
Selain itu Anda juga dapat menggunakan beberapa even untuk masuk ke perintah berikutnya yang 
sama, seperti ini: 
on (release, rollOut) { 
    gotoAndPlay(2); 
} 
Uraian di atas merupakan dasar dari sebuah navigasi movie Flash 
 
 
 
 
 
 
 
 
 
 
 
 

Macam-macam Actions: 
1. Actions Frame: Action yang diterapkan pada frame (klik kanan frame ���� Actions). Action 

akan dieksekusi pada saat playback berada di frame yang diterapkan action 

2. Actions Button: Action yang diterapkan pada tombol. Action akan dieksekusi pada saat 
user berinteraksi dengan tombol misalnya klik tombol, rollover dan sebagainya. 

3. Acctions Movie Clip: Action yang diterapkan pada movie clip. Action ini menggunakan 
event untuk mengeksekusi action 
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LATIHAN PROYEK PRESENTASI 
• Buka file baru dengan ukuran stage 800 x 600 pixel 

 
• File baru yang dibuat merupakan Scene 1 yang akan digunakan sebagai halaman slide 1. Dalam 

kasus ini kita memerlukan 3 buah Scene/ Slide. Untuk itu tambahkan 2 Scene lagi dengan cara 

klik menu Window � Other Panels � Scene 

 
• Maka akan muncul panel Scene, klik sebanyak 2 kali tanda + (Add Scene) pada panel Scene 

untuk menambahkan 2 buah Scene/ Slide. 

 
• Selanjutnya Scene 1 bertindak sebagai halaman muka presentasi, Scene 2 sebagai halaman isi, 

dan Scene 3 sebagai halaman akhir (Penutup/ kesimpulan). 

• Kemudian desain semua Scene tersebut sesuai dengan isinya. 
Scene 1/ Halaman muka 
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Scene 2 

 
 
Scene 3 
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• Catatan: dalam melakukan desain di Flash, teknik dalam menggambar harus diperhatikan seperti 
meletakkan objek yang berbeda pada layer yang berbeda, teknik pewarnaan dan lain 
sebagainya. 

 
Membuat tombol navigasi antar Scene/ Slide 

• Klik menu Window � Common Libraries � Button 
 

 
 

• Untuk memilih button yang akan digunakan, pilih folder button yang akan digunakan, kemudian 
seret ke bagian stage Anda. Lengkapi tombol navigasi pada semua Scene/ Slide seperti pada 
contoh desain di atas. 

• Selanjutnya kita akan menjalankan tombol navigasi antar slide tersebut dengan perintah Action 
Script. 

• Tombol next/ forward Scene 
- Klik kanan tombol next/ forward 
- Pilih Action 
- Tulis script berikut: 
on(release){ 
 gotoAndStop("Scene 2",1); 
} 

- Maksud perintah di atas adalah jika tombol diklik, akan menuju ke Scene 2 frame 1. 
- Dengan cara yang sama, buat tombol-tombol navigasi yang lain pada setiap slide tentunya 
dengan arah Scene disesuaikan menurut tujuan pada saat tombol diklik. 

• Setelah itu lakukan test movie dan pastikan semua navigasi antar slide/ scene berjalan dengan 
baik dengan tidak ada eror. 

• Jika sudah tidak ada keterangan eror, terlihat bahwa animasi akan berjalan cepat bolak-balik dari 
Scene 1 hingga Scene 3. Supaya tidak terjadi hal demikian, maka ketika aplikasi dijalankan 
pertama kali, harus dihentikan dulu jalannya animasi.  
Langkah tersebut dilakukan dengan memasukkan action frame pada Scene 1 yaitu dengan cara 
sebagai berikut: 
- Tambahkan layer baru dan beri nama layer action pada Scene 1. Perhatikan gambar berikut: 
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- Klik kanan frame 1 layer action, kemudian tuliskan script berikut: 
stop();//menghentikan animasi pada frame saat pertama kali aplikasi dijalankan 
fscommand("fullscreen",true);//mengijinkan animasi ditampilkan fullscreen 
fscommand("allowscale",false);//tidak mengijinkan tampilan animasi diubah-ubah  
fscommand("showmenu",false);//menu pada tampilan animasi tidak dimunculkan  

 
Membuat tombol navigasi antar frame 
• Masuk pada Scene 2 

 

 
 
Scene 2 di atas merupakan scene isi dimana berisi materi presentasi.  

• Tetapi sebelumnya, pada setiap layer masukkan frame (insert frame) sebanyak yang akan 
digunakan. Misalnya materi = 7, insert frame di frame 7. Sesuaikan dengan banykanya materi 
Anda masing-masing. 

Tambah layer 
baru 

Klik kanan 
dan masukkan 
actionnya 

Beri nama layer: action 
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• Langkah tersebut dimaksudkan supaya semua layer akan dianimasikan sebanyak frame yang 

sama. 
• Selanjutnya tambahkan layer baru, beri nama layer materi. Di dalam layer materi ini akan 

dimasukkan materi-materi presentasi pada setipa framenya.  
Frame 1: materi 1, Frame 2: materi 2, Frame 3: materi 3, begitu seterusnya hingga materi 
terakhir. 

 
 
 
 
 

• Pada frame 1, klik kanan kemudian pilih Insert Keyframe. Langkah ini bertujuan untuk membuat 
ruang untuk objek yang siap dianimasikan. Selanjutnya masukkan materi 1. 

• Pada frame 2 dan seterusnya, klik kanan frame-nya, kemudian pilih Insert Blank Keyframe. 
Berbeda pada frame 1, Insert Blank Keyframe dimaksudkan membuat ruang kosong untuk 
dimasukkan objek yang berbeda pada setiap frame. Setelah memilih Insert Blank Keyframe, 
masukkan materi-materi sesuai dengan urutan frame-nya. 

Beri nama layer: materi 

Tambah layer baru 

Klik kanan pada 
frame 1, 
kemudian pilih 
Insert Keyframe 
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• Setelah selesai menyiapkan materi, buat tombol next dan previous sebagai tombol navigasi antar 
materi dengan menggunakan text tool. Sebelum dimasukkan action, harus diubah terlebih 
dahulu text next dan previous menjadi tombol dengan cara: 
- Klik text Next � pilih menu Modify � Convert to Symbol 

 
- Selanjutnya akan muncul jendela Convert to Symbol � pilih tipe Button (untuk mengubah 
menjadi symbol button/ tombol) � OK. 

 
- Selanjutnya klik kanan tombol Next, pilih Action dan masukkan script berikut: 
on(release){ 
 nextFrame(); 
} 

- Action tersebut berarti bahwa ketika tombol diklik, maka animasi akan berpindah ke frame 
selanjutnya (navigasi berjalan). 

- Dengan cara yang sama lakukan pada text Previous tetapi scriptnya diganti dengan: 
on(release){ 
 prevFrame(); 
} 

- Action tersebut berarti bahwa ketika tombol diklik, maka animasi akan berpindah ke frame 
sebelumnya (navigasi berjalan). 

• Lakukan test movie dan pastikan tombol navigasi berjalan dengan baik. 
 
Tombol pada materi 

• Ubah menjadi symbol button semua text materi, kemudian mulai dari materi pertama (tombol 
pertama materi) klik kanan � pilih actions � masukkan script berikut: 
on(release){ 
 gotoAndStop(1); 
} 

• Untuk materi kedua ganti angka 1 menjadi 2, materi ketiga menjadi 3 dan seterusnya sesuai 
dengan letak materi berada di frame berapa. 

• Lakukan test movie dan pastikan tombol berjalan dengan baik. 
• Jika sudah tidak terdapat eror, proyek presentasi tahap pertama selesai. 
• Perbanyak latihan dan ulangilah praktik di atas untuk memahami perintah-perintah action di 

atas. 
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